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Conventions
For the tips about using the keyboard and the mouse | have assumed that you have a standard:
e US keyboard, with 102 keys (you will find in this book some comments about non-standard laptop

keyboards);
e Three-button mouse (in fact: two buttons and the wheel in the middle. When you click the mouse
wheel, it acts like the third button).

Command invocations are marked as follows:

Menu ->Command means invoking a command named Command from a menu named Menu. More
arrows may appear, when the menus are nested!
Panel:Button means clicking a button named Button in a dialog window or a panel named Panel.

Panels are parts of Blender screen (for more explanation — see ,Volume II: Model-
ing”). Sometimes | may also mention other dialog controls, like a checkbox or a drop-
down list.

Pressing a key on the keyboard:

[aitHK] the dash (“-“) between characters means that both keys should be simultaneously
pressed on the keyboard. In this example: while holding down the EH key, press the
(K] key:

E, EH the comma (“,”) between characters means, that keys are pressed (and released!)

one after another. In this example type [G] first, then [X] (as if you would type “gx").

Pressing one of the mouse buttons:

left mouse button

right mouse button

middle mouse button (mouse wheel pressed)
mouse wheel (when it is scrolled)

= —
<

Last, but not least — the formal question: how should | address you? Typically the impersonal form (“something
is done”) is used in most manuals. | think that it makes the text less comprehensible. To keep this book as read-
able as possible, | address the Reader in the second person (“do it”). Sometimes | also use the first person (“I've
done it”, “we did it”). It is easier for me to describe my methods of work in this way?.

1 While working on this model | thought about us — you, dear Reader, and me, writing these words — as a single team. Maybe an imagi-
nary one, but somehow true. At least, writing this book | knew that | had to properly explain to you every topic, with all details!
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Chapter 1.  Software Installation

In this chapter we will discuss briefly how to install the software we will use In this volume it is just one program:
- Blender: the 3D modeling software;

This software is released under the GPL (i.e. Open Source) license. It means that no one can charge any fees
for it. (Of course, you can still make voluntary donations. You can find detailed descriptions how to do this on the
websites of these projects).

| suppose that most of the readers of this book use a computer with the Windows operating system. In the in-
stallation instructions | have concentrated solely on this environment. | also use it on my computer. | have no
experience with Linux nor Mac OS, so | will not write about the things that | do not know. If you are using a non-
Windows system — find the installation instructions of these programs on their websites.

| also prepared some additional resources for this book, and packed them into a few zip files, for downloads:

e You can download the files that accompany this book form http://airplanes3d.net/va3_e.xml. It contains
their latest versions (I update them from time to time, to match the current Blender release)?.

From this web page download following files:

- source.zip: contains useful add-ons, scale plans, a few factory blueprints of the P-40, and some other
reference materials;

- la5.zip: contains the exemplary model, used in Chapter 2;

- p40.zip, p40w.zip: contain the subsequent P-40 models (*.blend files), and background pictures. Each
*.blend file from their history\ folder contains the result of a section from this book

Unpack all these *.zip files into a single folder. They will create following structure of subdirectories (files not
listed above belong to the other volumes of this book):

i < Unpack all the downloaded files
CI your_dlrectory, into this folder, and they will
create following subdirectories:
CI model
Cl|a5 7777777777 '« [contents of the la5 zip file
[]pa0
ECI baCkground 3 contents of the p40.zip and
: . 14 [p40w.zip files
;CI history 3
P contents of the textures1.zip and
CI textures & textures2.zip files
ECI optional ! — Icontents of the optional.zip file I
source — Icontents of the source.zip file I

,,,,,,,,,,,,,,,,,,,,,,,,

1 On this web page | will also place answers to the readers’ Frequently Asked Questions. They will appear some time after the release of
this book.

Virtual Airplane — third edition www.airplanes3d.net
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Chapter 1 Software Installation 19

1.1 Blender Installation

| used Blender 2.7 in this book. You can also install previous versions of this program in the manner described
below.

Download the installation file from the Blender Foundation website: http://www.blender.org. When | was writing
this edition of the “Virtual Airplane”, they were available at http://www.blender.org/download/ (Figure 1.1.1).
However, | cannot guarantee that they will always be in the same place. If you find that this virtual directory is no
longer valid, start from the main page of this website?.

| |B- Google P B 3 H

A®)blender Features  Download

Support  Getlnvolved  About  Store

:“".-"-.
 DICTNOGH Zess o d AN

External Renderers  Previous Versions ~ Requirements

’ Open Animation Film - Crowd funding now!
Download Blender 2.70a for Windows "

/, neGOOSEBERRYsrosect

Blender 2.70a is the latest stable release from the Elender Foundation
To download it, please select your platform and location. Blender is Free &

Blender 2.70a was released on April 11, 2014

The release logs for this release can be found here.

Donate to the Blender Foundation

el

LIV Mac OSX  GNU/Linux  Source Code  Daily Builds

You can download regular
Windows installation program

g from one of these servers...
(3 installer )

(3
\ ... but | prefer to download the

€) 1¥Biender reports an error on startup, please install the Visual C++ 2008 Redistributable Package. 32bit / 64bit plain, Zipped file!

1
2

Figure 1.1.1 The page with Blender installation packages

At this address you will find shortcuts to the Blender versions compiled for different operating systems (Win-
dows, Linux, Mac OS ...). In Figure 1.1.1 | have chosen the 64 bit package. This is the preferred version2. The
32-bit Blender version is intended for the older, 32-bit Windows versions (like Windows Vista or once popular
Windows XP).

Each version for Windows is available in two forms: the installation program and the *.zip archive. If you like the
Windows installation programs, you can download it from there and run on your computer. It will ask you about
the folder in which to place Blender, and after a while you will have it installed.

1 From this site you can also download the earlier versions of Blender. | mention this because you may read this book some time after its
publication. The best Blender version to follow this tutorial is 2.7 (in the time of writing: 2.71).

2 The 64-bit version of this program has access to more RAM. It allows you to use textures larger than 4000x4000 pixels. This feature can
be very useful when you want to reproduce the model surface with more accuracy. In this book the largest texture has size of 4096 x 4096
pixels. However, if you start rendering a very big picture — for example, an A4 page in resolution of 300dpi, and textures of 8192x8192px —
the 32-bit program will end with an error, while the 64-bit version will do it correctly.

© Witold Jaworski, 2009 - 2015.
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20 Creating the Model

However, | always prefer to know exactly what is happening to my computer®. The point is that Blender practi-
cally has no external dependencies. Therefore, | believe that the best way to install Blender is to unpack its *.zip
file. In this manner you know exactly what you are doing. Just:

1. download the appropriate *.zip file from the BF page (Figure 1.1.1). (It contains a folder with ready to
use program files);

2. unpack content of this package to your hard disk, for example to the C:\Program Files\Blender folder;
3. add the shortcut to C:\Program Files\Blender\blender.exe file to your desktop and/or to your Start menu;
4, optional: associate the *.blend file extension with the blender.exe (just to double-click any *.blend file,

and Windows will ask you about the program to open it);

If you have any doubts about the course of this simple procedure, you can find the detailed description on how
to do it on page 253.

When you want to upgrade Blender to the newer version — you do not have to run the installation program once
again. (Though, of course, you can do it). Do it in the following way:

1. change the current Blender folder to “Blender-XX.X”, where XX.X is the number of the version it con-
tains. For example: before installing the version 2.72 | have changed the name of existing Blender folder
to Blender-2.71,;

2. download from the BF page the *.zip file with the new Blender version;

3. unpack its contents to the C:\Program Files\Blender folder (you have to create a new one);

In this way, all the Start menu shortcuts, and the association with the *.blend file extension will be automatically
transferred to this new Blender version — you do not have to change anything more.

When you start the new Blender version for the first time, it will propose you to import your settings from the
previous one (Figure 1.1.2). Just do not miss this moment and click the Copy Previous Settings button on its
splash screen:

gooseberry.blender.org

Link
£ Support an Open Animation Movie

® Donations

Click this button to copy your
B Credits settings from the old Blender
version to this new one

® Blender Website

® Python API Reference

Figure 1.1.2 The Blender splash screen, as on the first run of a new program version

1 Thanks to this | have used the same Windows installation for many years — and it has never been reinstalled! What's more, even with the
passage of time it has not slowed down, as | have often seen on the computers of other users...

Virtual Airplane — third edition www.airplanes3d.net
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You can always use previous versions of Blender when you keep them in renamed folders. Just run the
blender.exe file from such a directory, instead of using the desktop shortcut.

e  You can use many different versions of Blender simultaneously on your computer. Just place each of them
in a separate folder.

e Blender does not need an external Python installation. (You may encounter references about it on the In-
ternet). The external Python interpreter was an optional component in Blender 2.49 and earlier releases.
Since the version 2.5, Blender uses its own, embedded Python interpreter. This is because the whole
Blender user interface (windows, buttons, and menus) is dynamically created by Python scripts, every time
you open the program!

© Witold Jaworski, 2009 - 2015.
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Chapter 2.  Introduction to Blender 3D

In this chapter you will learn the Blender basics?. It discusses its GUI, navigation in the 3D space, and basic
object manipulation. You will use the shortcuts described here so often that soon you will do it instinctively.

To get somewhere, you need to make the first step. Some claim that the first one is the hardest. On the web
forums you can often read posts like this: “I would like to play with Blender, but at the first attempt | gave up”. |
also wanted to play with it. So | followed a tutorial or two and soon became hooked on this software.

| think the myth that Blender is a difficult program is exaggerated by those who want to learn everything at once.
Dear friends, it is not possible. Sometimes you have to sit down and read, and learn2. So far, nobody has in-
vented such pills like those from the “Matrix”, which would allow you to swallow a whole book and know every-
thing right away.

Once | carried out comparative studies of the user interface of different 3D systems. | can honestly say that
Blender has really a cool, consistent front end. It is just a little unconventional. Anyway, in version 2.5 its Ul was
rewritten from scratch, to become even easier. In the subsequent sections of this chapter | will describe, step by
step, the conventions of the Blender environment. When you learn them, you will discover that it is not so diffi-
cult to master the whole thing. It enforces a good habit of working with the computer using both hands (usually
with the left one on the keyboard, and the right one — on the mouse).

Most of this training we will carry out using a model of the La-5 fighter. You will open this file, examine its con-
tent, and learn basic methods of editing (transforming) the Blender objects. We will do this by moving and rotat-
ing the camera around the scene. (Yes! Like in a real studio, we can have the cameras here!). All in all — after
reading this chapter you will already know how to “pose” a model in Blender. At the end we will also render the
final picture of this airplane.

e Inthis chapter we will use some materials from the source.zip and la5.zip files, which accompany this book
(see page 18 to get the address of their download site)

1 This chapter contains detailed instructions how to use Blender. | have broken here the rule adopted in this book (the first part of the book
describes what to do, while the second part — ,Details of Program Usage” — how to do it). | did so because the material presented in
this chapter is necessary for all further work.

2 A few years ago | was examining skills in the office software of a group of graduates. Each participant of this test had to declare his/her
level of experience in the word processor. Nobody stated his experience level below 80%. Then they received tests, appropriate for the
declared knowledge. Few of them demonstrated skills on the level better than 50%. So why are such programs considered to be easy to
learn? Because hundreds, or even thousands of programmers had polished their user interface for a decade. This tuning was intended to
achieve quite a specific learning curve. The absolutely basic steps had to be easily conducted by an average office worker. (In most cases,
not particularly fluent in the computer use). The remaining features are the domain of few insiders: the individuals brave enough to delve
into such esoteric and difficult to understand texts as in the "Dummies" books. The Blender learning curve is different — steep, but in steady
pace, without excessive facilitation at the outset. On the other hand, there is no great gap between the first step and the next ones.
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2.1 Screen layout

Figure 2.1.1 shows how your screen looks like when you open Blender for the first time:

L) oeout (RG] scene SRSt R

User Persp

1920 px * | [ * Start Frame:
1080 px | | *EndFrame: 250~

(1) Cube

@ Object Mode b + )0 Ia Hlae)ZED

(sat 1] et 250 M 1 SRR oo RN

Figure 2.1.1 The Blender initial screen

It does not look like a typical Windows application, does it? | confess that when | started working with rewritten
from the scratch version 2.5 of Blender, for the first 15 minutes | just sat, staring at the screen. Everything on it
was so “refurbished” that the whole thing was completely new for me! | even did not move the mouse — | was
not sure where to begin. It happened, although | had worked for four years in previous versions of Blender (2.4),
and even before this | looked at these Blender 2.5 beta versions once or twice. After those first 15 minutes of
contemplation | began to repeat the simplest steps, then looked into some tutorials — and it went, somehow. |
hope that the memory of this beginning will help me to write this introduction better.

The screen layout of Blender seems to be prepared for the newer displays that have an aspect ratio of 8x5.
(The previous Blender versions — up to 2.4 — were better fitted to the aspect ratio of the old monitors: 4x3).
Blender is written for several operating systems: Linux, Mac OS and Windows. In each of them it looks (and
works) in the same way?. Inevitably, the user interface of this program has a unique style that distinguishes it
from the others. Let's start by discussing its basic elements.

1 How did they achieve such compliance? It is possible because Blender “paints” its menus and buttons using the OpenGL standard com-
mands. In each of these operating systems there is a set of procedures that can be used by applications to create realistic, three-
dimensional images. Such a set in the programmers’ jargon is called a “library”. These libraries implement procedures of the OpenGL com-
mand set. This set, initially named GL, was developed in the early 90’s of 20" century for Silicon Graphics workstations. (In that time they
were true “rockets”, with their hardware graphics accelerators. Such a workstation was a dream for all computer graphics fans, and had
appropriately high price). Shortly afterwards GL converted into multi-platform OpenGL, began to be used by many CAD, CAM and GIS
applications, in different operating systems.

In 1995 it was added to Windows NT, then to Windows 95. (Although their manufacturer — Microsoft — had already promoted a competitive
product, named DirectX). Blender always used OpenGL to draw the content of its scenes. Interestingly, at some point its author came up
with the idea that the same commands can be also used to draw the two dimensional elements of the screen. In the result the whole Blend-
er user interface is drawn using OpenGL. This way, its Ul code does not depend on the operating system. This solution gives also a relative-
ly small size of the program (there is no need to use complex, standard window libraries like wxWidgets, Qt, or GTK+). Another interesting
“side-effect” is the ability to smoothly resize (scale) all the user interface elements.

© Witold Jaworski, 2009 - 2015.



24 Creating the Model

The Blender screen is divided into rectangular areas. They are also referred as “windows”®. Unlike in the con-
ventional windowing systems, Blender windows never overlap. Personally, | think it is an advantage. The over-
lapping windows look good only in the advertising materials of the popular editors. When it comes to the real
work, everyone sets them in a way to see all of them at once. On the default Blender screen you can see five
windows (Figure 2.1.2):

Outliner

Set Origin

This is not a “window”
— it is the toolshelf of
the 3D View window

Mitchell-Netravali ¥

Figure 2.1.2 Blender - the areas of the default screen

- 3D View window: shows a three-dimensional “scene” that contains the model (here: a cube);

- Outliner window: the structure of the scene, presented in a symbolic way;

- Properties window: the area for most of the buttons, numeric fields and switches, which give you con-
trol over the scene objects (their properties);

- Info window: contains the main pull-down menu and the space for the program messages;

- Timeline window: used in animations;

To resize any of these windows, you can drag its border with the mouse (Figure 2.1.3):

Blender Render 3
In  that moment, E

press

(]

The cursor changes
its shape, when it is
over the window
border - where you want it — release the .

| ...and drag the window border. When it is [l

Figure 2.1.3 Resizing Blender windows

1] know that it only resembles the basic classic windowing environment a bit. However, this name prevails in the documentation on
wiki.blender.org and various other sites. With the introduction of Blender 2.5 its authors attempted to use the term region, or area, but
somehow these names have not been widely accepted. The content of a single Blender window is also sometimes referred as an editor.
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Let's remove from the Timeline window, because we do not need it at this moment. It means joining it with the
adjacent area. To join two windows, place the mouse cursor on the border you want to remove, and click the
[ZYE. It opens the Area Options menu. Select from it the Join Areas command (Figure 2.1.4a):

Click on the window border, to
open the Area Options context menu...

{1} Cube

be removed.

IR | o syne

Figure 2.1.4 Joining Blender windows

When you invoke this command, Blender will point to the window to be eliminated (Figure 2.1.4b). It is always
the area below the mouse cursor.

e The Blender window which currently is below the mouse cursor is called the active window. (It is a little bit
lighter, but you cannot see this on the pictures in this book — the difference of the shades is too small).

Click to finish this operation — you screen should look like that in Figure 2.1.5:

Blender Render ¥ | B

7 User Persp
=

Duplicate Linked S '
(G1_renier_ pmation [3)_sodo ]
Joi

n mage Editor =

Set Origin v

.S 1920 px © * Start Frame: 1"
4y 1080 px » 4End Frame: 250
50% “ Frame Step: 1

ol 1.000 * LSS 3
i 1.000 -

5 BEM 11 16 | Mitchell-Netravali 5

, ‘Size:  1.000px " A8

Figure 2.1.5 The screen after joining the Timeline window with the 3D View window

o Before the final click, you can cancel this operation just pressing the |Esc| key. (This key always cancels the

current operation in Blender).

© Witold Jaworski, 2009 - 2015.




26 Creating the Model

Similarly, to split a window use the Area Options 22Split Area command. You can also do this in another way —
using one of its handles, placed in the upper left and lower right corner of each window. They look like a “ribbed”
triangle (Figure 2.1.6):

Blender Render ¥ o] ~ Blender Render ¥ ]

The cursor changes its shape
over the window handle

New window

Press over the E
handle...

...and drag the cursor, holding [E\=]
Render Presets down. Render Presets

Figure 2.1.6 Using the window handle to split Blender windows

Grab the upper window handle with the mouse (press the and hold it down) and move it vertically down the
window area. For this movement Blender splits the window horizontally (Figure 2.1.6). You will suddenly find
that you are dragging the bottom edge of a new window. If you move the handle horizontally, Blender will split
the window vertically.

e The content of the new window is always an exact copy of the split window

You can also use handles to join two Blender windows. Simply drag it into the area that has to be eliminated
(Figure 2.1.7):

User Persp

(1) Cube

@ Object Mode

¥ Object Tools

Transform:
Translate
Rotate
Scale
Dhject:

Duplicate Objects
Delete

No B = N |

Figure 2.1.7 Joining Blender windows with the handle

et

annns anuns = @@ * ¢

Blender dynamically points this active window with an appropriate arrow (Figure 2.1.7). Just release the , to
join these two areas.
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As an exercise, split and/or join Blender windows creating screen layout as in Figure 2.1.8:

Ol Blender Render ¥ | A&
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(1) Cube Histon, (1) Cube 5

® Object Mode ¢ 2 [ © Object Mode

Figure 2.1.8 Alternate screen layout

Let’s discuss the basic elements of a Blender window (Figure 2.1.9):

User Persp

Opens another shelf
Window shelf (see. page 28)

(the Tool Shelf, in
this case)

Set Origin

; Pull-down menus
Selection of the _ Other window

to editor (the content header controls
of this window)

(1) Cube

Header ; g|

Figure 2.1.9 Elements of the Blender window

Each Blender window has a header. Sometimes this element is placed at its top (as its hame suggests), some-
times at the bottom. The header contains pull-down menus and some other controls.

© Witold Jaworski, 2009 - 2015.
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On the left side of the header there is a drop-down list. You can use it to select the type of the editor to be dis-
played. For example — you can display the scene structure, switching to the Outliner editor (Figure 2.1.10):

=] Python Console

B& File Browser (1) Cube (1) Cube

L
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® Object Mode :
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A

== Propertie
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=) Node Editor select the Outliner

e
3

B Text Editor
Video Sequence Editor Igba
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= NLA Editor Outliner plicatE

2 DopeSheet Delete
3/ Graph Editor i (the structure of the scene) Jain

B Timeline
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L = ® Object Mode B O All Scenes

Figure 2.1.10 Changing the window type

Some types of Blender editors (3D View, UV/Image Editor, Text Editor) have a toolshelf, placed on the left side
of the window. You can push/pull it using the menu command (View 2Tool Shelf), but it is much easier just to
press the [T] key (Figure 2.1.11):

2 e User Fersp You can also click this icon
to open the Tool Shelf

Press

I
v

Figure 2.1.11 Flipping the Tool Shelf visibility

In a similar way you can show/hide the Properties shelf, placed on the right side of the window. Use just the

key or the menu command (Figure 2.1.12):

This icon also opens
MNavigation the Properties shelf Locatiol
O S—— ‘¥ o.ooooor || TS
View Persp/Ortho Numpad 5 You can also flS visibility -~ 000000

Cameras by pressing the [N| key.

Left Ctrl Numpad 3

Right Numpad 3 ‘1| : ; o k‘

Back You can open it
Front using menu.
n Ctrl Numpad 7
Numpad 7

Camera Numpad 0
W Tool Shelf

”

Figure 2.1.12 The Properties shelf and various methods of controlling its visibility
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When the mouse cursor is over the header, you can click to open its context menu. Depending on what
has been clicked, Blender opens a longer or shorter menus (Figure 2.1.13):

a)

You can open the Header menu from
each of these menus

Header

4 Collapse Menus

Edit Translation

Online Manual

Online Python Reference
You can directly open Edit Source
You will see this menu the Header menu When you click on =R T

when you click m clicking m on its a control, Blender opens a
on a pull-down menu background longer context menu

Maximize Area  Ctrl Up Arrow

L2~ ™ cloal % g
Figure 2.1.13 Context menus of various Blender GUI elements

The control context menu (Figure 2.1.13c) contains some commands that are not available in other contexts.
The Reset to Default Value command sometimes can be useful when you are not sure what the default value
is for a particular control. The Online Manual command opens the relevant part of the Blender guide (an article
about clicked control from wiki.blender.org). The Edit Source and Edit Translation commands are useful only for
Blender developers or translators. A shorter version of this menu (Figure 2.1.13a) will appear when you click
on one of the pull-down menu labels. In both of these menus you will find the Header submenu that con-
trols the window header (see Figure 2.1.13a and Figure 2.1.13c). Blender can directly open this Header menu
when you click somewhere in between the window header controls.

Contents of the Header menu is useful for screen layout modifications. When you invoke the Header 2Flip to
Top command, the header will be placed on the top of its window (Figure 2.1.14):

This command places
From the Header menu the header along the
invoke the Flip to Top window top edge.
command

Header

Flip to Top k‘

& Collapse Menus : (1) Cube

Maximize Area  Ctrl Up Armrow User Persp

Figure 2.1.14 Flipping the header on the top of its window

When the header is on the top of the window, Blender modifies its Header menu. Now you will find there a
command named Flip to Bottom, instead of the Flip to Top item. You can use it to bring the header back to the
bottom.

© Witold Jaworski, 2009 - 2015.
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Starting from Blender 2.70 there is a new option in the Header menu, named Collapse Menus. When you turn it
on, the pull down menus from the header “shrink” into a single item (Figure 2.1.15):

@ View Select Add  Object e Header
A Flip to Bottom ’
" .

By default, each of these

Now they are
Add  ShiftA merged into a
pull-down menus is Maximize Area  Ctrl Up Arrow single pull-down
displayed separately menu

Figure 2.1.15 Shrinking window header menus

Use another command from the Header menu — Maximize Area — to temporary extend active window on the
whole Blender screen. However, you can to do the same using the keyboard shortcut: — (Figure 2.1.16):

O -9 Blender o =
Tershte You can also revert this window
Rotate to its previous state by clicking

e

the Back to Previous button

inked

Smooth | Flat

Undo | redo
History

e | 1E

(1) Cube

Flip to Top ® Object Mode

llancs Me ——————— =& You cannot split such a temporarily it
= enlarged window — thus there are no /

Persp Mo r
You can also use this command characteristic handles (see Figure
from the Header menu 2.1.6, page 26) in its corners.

Figure 2.1.16 Maximization of the window

The reverse effect — reduction of the window to its original place on the screen — you can obtain by pressing
the El keys (or invoking the Header 2Tile Area command — but it requires too many mouse “clicks”...).

So far we have learned three of the Blender keyboard shortcuts: [T}, [N], and [ctri]-[¥] [a]. For each of them I also

specified the corresponding menu command. Which method of command invocation is better: the menu or the
keyboard shortcut? Shortcuts are obviously faster. However it is not worth learning all the program shortcuts,
because our heads have finite capacity. (Many Blender guides focuses on the keyboard shortcuts as the main
way of invoking its commands. | think that it also contributes to a false impression that this program is difficult to
learn). It is easier to invoke the less frequently used commands from the menu, because you have only to re-
member “more or less” the place where you can find them. When you notice that there is an often used com-
mand — look to the right side of its menu name. You will find there its keyboard shortcut. (If it does not exist,
you can configure your own — see page 263). Describing this program, | will always tell you where to find a
particular command in the menu. | will also specify its keyboard shortcut, if it exists?.

1| strongly recommend you to use keyboard shortcuts. | remember that in one manual for designing user interfaces, its author complained
that today's solutions are designed for “Napoleons”. What does it mean? Do you remember the favorite attitude of this man, repeated on
many sketches and paintings? He is always doing something with one hand — pointing, waving, and signing. Simultaneously his second
hand is idle, stuck into his coat. Too often the software interface is designed as if you had only one hand — the one which holds the mouse.
The second hand lies idle somewhere on the side. Programmers often forget that we have two hands. If we were able to use both hands
efficiently, we would work faster. For example — do you know how efficient in text editing a man would be, who types with one hand on the
keyboard and in the same time uses the second one to select the text with the mouse? Keyboard shortcuts allow Blender to achieve similar
effect in modeling. They allow to “play on both hands” with the computer. You should practice the shortcuts used in the mesh edition (it is
the most time consuming operation).
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You do not need to laboriously rearrange the borders of the windows every time. Blender offers you some ready
to use screen layouts. They are available in the Screen lay-out dropdown list, placed on the Info window head-
er (Figure 2.1.17):

3D View Full The Screen lay-out list contains
alternate screen arrangements

Animation

Compaositing

Game Logic
Motion Tracking
Scripting

U\ Editing

Duplicate
Video Editing

Duplicate Linked
Delete

e —— When there is a lot of items on this
Set Origin list, you can filter them using this
Search field

('smoctn | Fat__]

Figure 2.1.17 Selection among one of stored screen layouts

The screen layout we have modified so far is named Default. You will use it most of the time, during modeling.
The UV Editing and Animation layouts will be used later. Try to select another screen layout (Figure 2.1.18):

Blender

R vew [ 0o ) | R

“x: 1920 px» | [ Start Fra: 1
Y- 1080 px - | | <EndFr 250+

00 0 a0
D IR BERIEE] vo sy N

Figure 2.1.18 Other, predefined screen layouts: UV Editing and Animation
Of course, you should treat these layouts only as suggestions. You can completely rearrange them. The Screen

lay-out control allows you also to define your own layout. To create it, use the button, located on the right

side of the list. The next button — k&=l — deletes (removes from the Blender file) the current screen layout. You
will find more about this control and the management of the screen layouts on page 283.
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You can change the Blender configuration in any window, switching its content to the User Preferences editor.
This editor is available on the Editor type list (just above the Outliner item — see also page 28, Figure 2.1.10).
Nevertheless, | prefer to invoke this window in another way: from the File menu (Figure 2.1.19):

A Blender 20 Blender User Preferences g@g|

Editing Input Addons Themes File System
Ctrl N ' ' ' ' '

Ctrl O v Manipulator
shift Ctrl O Size: 15

iy v Show Python Tooltips Handle Size: 25
v Object Info Hotspat: 14

Ctrl 5
Shift Ctrl 5 | View Nams +" Global Pivot
v Playback FPS ~" Camera Parent Lock

- : | I i *  Object Origin Size: 6 * - ‘ Top Level: 5 .
+  RotationAngle:15 Sub Level: 2

& Link Ctrl At O o Display Mini Axis
Append shift F1 q Gizer 35 »

Import 1 Brightness: 8 4 “Minimurn Grid Spacing: 35"

Export

v Show Splash

‘e A
Minimal Info v

= External Data

Quit cd Q

Figure 2.1.19 Accessing the program configuration

On the top of User Preferences window you can select one of its sections (Interface, Editing, Input...) (Figure
2.1.20):

-2 Blender, Usen Preferences

Selection of the
window section erface Editing Addons Themes

Blender

“Drag Threshold: 5+

Left If you use a laptop or other computer

without the full keyboard — turn on this
Emulate Numpad option!

Trackball

s

Saves configuration
Dolly v
iy Import Key Configuration... Export Key Configuration...

Figure 2.1.20 The User Preferences window
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A detailed discussion of what should be altered in the default Blender configuration can be found on page 261.
Here | would like to indicate the option that we will need in the next section. If you use a laptop or any other non-
standard keyboard without the numeric pad — in the Input section turn on the Emulate Numpad option, as in
Figure 2.1.20. Then save this change by pressing the Save User Settings button. (You will find it at the bottom,
on the window header).
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Starting from the release 2.66%, Blender stores its configuration in a special file named userpref.blend. This file is
located in a separate folder of the Blender configuration data, in the user home directory.

e You can learn more about the settings that are stored in each drawing, as well as about the ones which are
stored only in the userpref file (and the location of this file) on page 261.

Another interesting feature of Blender are short tips that appear on every element of the screen. They are con-
trolled by the Tooltips option in the User Preferences:Interface section (Figure 2.1.21a). Just hold the mouse
cursor for a while over an unknown checkbox or button— and you will see its hint (Figure 2.1.21b):

a) Editinn
Turn  this
option on...

Editing Input Add-Ons Themes System

. then hold the mouse over a
control, for a while. Blender will
' Tooltips display its short description

; Tooltips | I

~"“Show Python Tooltips
' Object Infe

J n
' Show Python Tooltips Use the depth under the mouse to improve view pan/rotatefzoom functional ity
" Object Info wihon: UserPreferencesView.use_mou ito_deptt

This option controls appearance of the bottom line — the Blender
Python API expression for this control. Only for the programmers!

Figure 2.1.21 Tooltips for the screen controls

The bottom line of the hint is displayed in a different color. It is the name of this property in the Blender Python
APl — an interesting thing only for the programmers! If you don’t need this information, just turn off the Show
Python Tooltips option (Figure 2.1.21a).

By the way — have you noticed, that currently you have two Blender screens? (Figure 2.1.22):

) Blender - B

]

| Rotate |
| scale | Interface Input Addons Themes Systemn

ObData * Eraser Radi: 25 px * This window can
be also split
* Manhattan D:1 px ©
 Euclidean Di: 2 px * Auto Keyframing:

|
4 Show Au... Warning = Ret
Surface

.
Oy World | Curve

v Text
' Metaball

AutoCla... I Arnatires

" Global Undo -
“Stes: 5 XYZ to RGB ~Hiama

“ Memory Limit: 0 *

| Rotate |
X e Visi:0.250
[ oin

You can switch its content
into any other editor type!

Set Origin

Figure 2.1.22 Two Blender screens

1 All previous Blender versions stored the user settings in so-called startup file (startup.blend). This file contains also the default scene which
is displayed when you open the program (you can see its content in Figure 2.1.1). In these old versions the user had to store the altered
settings together with the current scene. In practice we always had to save the Blender settings for an empty scene!
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34 Creating the Model

The second screen (created by the File 2User Preferences command) has the same properties as the first one
— you can switch its contents into another editor type (such as the 3D View). It can also be split into several
areas. If your computer has two displays, operating in so called “extended desktop” mode! — you can place a
Blender screen on each of them. Both screens will keep showing the same scene (Figure 2.1.23):

2 Blender User Preferences
Top Ortho

@obectMode [ @ §

Right Ortho

®0bject Mode ¥

Figure 2.1.23 An example of Blender screen layout in the “extended desktop” mode

In practice, this mode doubles the available screen space, significantly improving ease of the work.

e There is another method of opening second Blender screen: in a 3D View editor open its View menu and
invoke the Duplicate Area into New Window command.

At the end of this introduction to Blender, let's mention how
to close this program. Of course, you can shut it down like

Ctrl M
Ctrl O
Shift Ctrl O &

any Windows application, by clicking on the button in
the upper right corner of its screen (window). There is also
another way to do it: use the File 2Quit command (Figure

2.1.24), or press the [ctri}{q] shortcut.

Recowver Last Session

Recowver Auto Save...

Save

e  After the Quit command Blender does not warn that
the current file contains unsaved changes!

Save As... This command saves
- current file as the Blender
Save Copy... startup file (i.e. initial

A YEPIN

content).

=

. . User Prefe
Perhaps such a behavior of the Quit command comes T e S

from the fact that it saves the current state to a special file e I S ‘
Load Factory Settings

that you can restore using the File 2Recover Last Session.

When you turn on the Interface:Prompt Quit configuration

option (see page 262) Blender will display a warning mes-

Link Ctrl Alt O
Append Shift F1

Import

sage when you try to close this window with button. This command

Export closes Blender

hh P Oi

Note that in the File menu there is also the command that
stores current scene as the initial content: Save Startup
File. Finally, when you have altered so many settings that S e T
you do not know which one is wrong, you have the Load
Factory Settings command here. It reverts Blender to its F19ure 2.1.24 Commands from the File menu.
initial state.

A=

1 Most of the laptops have this mode — because you can connect them to an external display.
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Summary

The Blender user interface is different from other Windows applications. However, “different” does not
mean “worse” — you will see this in the book;

Blender screen is divided into some areas, also referred as windows. You can move their borders (see
page 24), but they never overlap;

You can split or join Blender windows (as a result of the latter operation one of them is eliminated). You can
invoke these commands from the Area Options context menu (page 25). The same effect you can get by
moving their handles, placed in the lower left and upper right corner of each area (page 26);

Every type of Blender window has a header and working area, and some of them — also have “shelves”
(Tool Shelf, Property Shelf), located on their sides (page 27);

Window shelves can be “retracted” and “ejected” from the window borders by pressing the E key (Tool

Shelf) and the ||E|| key (Property Shelf). If you do not remember these shortcuts, use the commands from

the View menu (page 28);

To change the type of the current editor (the window content), use the dropdown list, placed on the left side
of the window header (page 28);

Blender has some ready-made screen layouts, intended for different stages of the work: modeling, textur-
ing, and animation (page 31). Every of them can be customized. You can also create your own screen lay-
out;

The screen area below the mouse cursor is often referred to in Blender as the active window (see page
25).

The active window can be maximized with the [CtrlHTl shortcut. Pressing these keys again restores the

a ke

original screen layout (page 30);

You can open many Blender screens (for the operating system they are just separate windows). When you
have two monitors, you can use both of them in this way (page 34);

The best way to open the configuration window is to use the File 2User Preferences command (page 32);
To save altered configuration settings click the User Preferences:Save User Settings (page 33). Blender
stores it in a file named userpref.blend, in your user profile. (More on this subject — see page 261);

When you invoke the File 2Quit command, Blender will not display any warning that the current file con-
tains unsaved changes. Instead of it, it saves the current scene state to a temporary file named quit.blend.
You can open it using the File 2Recover Last Session command;
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2.2 3D View — changing current projection

How long can we just play with the default cube on the Blender scene? It is a little bit boring, isn't it? You have
seen it enough in the illustrations in the previous section. Let's load a more interesting model!

First open the file named source\config\startup.blend (use File 2Open — see page 256). You can find it in the
source.zip file (see page 18). This Blender startup file contains the settings which | have prepared for this book.
To save them, click the Save User Settings button in the User Preferences window, and invoke the File 2Save
Startup File command (details — page 261). Then open the model\la5\la5.blend file. (You can find it inside the
la5.zip package that accompanies this book). Figure 2.2.1 shows how it should appear. We will use this La-5F in
subsequent sections of this chapter, to let you work on a real model.

Blender Render ¥

Camera
view X 1280px > | [ «StartFrame:  1*
v 960 px || < End Frame: 300 -
(1) 012.Body i | 50% )| “FrameStep: 1%

o5 © ObjectMode 5| @ 5| @) & .

241ps
Right Ortho

Box

a
4 Size:  0.750 px ©

(1) 012.Body (1) 012.Body

Figure 2.2.1 The La-5F model (content of the file that accompanies this book)
So we have loaded the model, now it is the time to explain how to explore it. Let's maximize its left side view
(Figure 2.2.2):

{1} 012 Body
[ eb © ObjectMode 5 @ ¥

Right Ortho

Press in

this window

(1) 012 Body {1} 012.Body

Figure 2.2.2 Maximizing the left side view

Do you remember it from the previous section? Place the mouse cursor over the 3D View window that contains
the left side view (Figure 2.2.2), then press the |E| shortcut. It will maximize this window into the whole

Blender screen. (I would like to remind you of this command, because it will be often used. You are usually short
of screen space, during modeling!).
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Now you can see this model more accurately (Figure 2.2.3):

Right Ortho Information about the

Press this button to tile o .
visible objects and the

this window (or press the

program state.
Gl o

{1} 012 Body
@ Object Mode 5 4PN Global 3 ): N EEy: BRI

Figure 2.2.3 Maximized window

Pressing E| (or clicking the Back to Previous button on the Info window header) will restore this window

into its original size and position. Yet let us stay for a while in this enlarged view.

The loaded model contains a lot of vertices and faces. You can read it from the state information, displayed on
the right side of the Info window header (Figure 2.2.3). This information is more visible when the window is max-
imized, because in this mode two dropdowns disappear (the screen layouts list and the scenes list — compare
Figure 2.2.3 and Figure 2.2.1). What do these abbreviations and numbers exactly mean? Let me explain:

- v2.70.5: this is the Blender version number (in this example: Blender 2.70, 5" release);

- Verts: number of vertices, used in the objects that are currently visible in this window. This airplane con-
tains 446 319 vertices. (It is a relatively detailed model);

- Faces: number of the faces, used in the objects that are currently visible. This model is built of 436 176
elementary faces;

- Tris: number of elementary triangles, used in the visible objects. Usually each quad face is built of two
elementary triangles, thus this number is two times greater than the number of faces. Of course, some
faces are triangular (1 tris per face), or can have more than 4 edges (in such a case it is built from more
than two triangles);

- Objects: number of selected objects, and (after the slash) all visible objects. This model is built of 357
objects, but none of them (“0”) is selected;

- Lamps: number of the light sources selected/currently visible in this scene;

- Mem: amount of the RAM, allocated to this program?. In this case — a little over 350 MB. Certainly, this
value should be less than the amount of physical RAM installed in your computer. In practice, the avail-
able amount of RAM depends on the Blender variant you are using. For the 32-bit variant, it can vary
from 1.3 GB RAM in Windows to 1.7 GB in OSX. On the other hand, the 64-bit variant of Blender can al-
locate, if necessary, the entire available RAM;

- 012.Body: active object name (what is an “active object” — see page 48, Figure 2.3.3);

! For those, who are not fluent in the computer terminology: the RAM is the "volatile” memory, which is cleared every time you turn off the
computer. Do not confuse it with the persistent storage memory of your hard drive!
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I am afraid that Blender can redraw this La-5 model rather slowly on many less powerful PCs. To remedy this |
suggest to hide some layers, as shown in Figure 2.2.4;

... when you do it, you will
notice that the number of
objects, vertices and faces
has decreased

This “gadget” controls the layer visibility.
Holding down the |Shift| key, click with

its cells, to set them as follows:

1) 012.Body

) Object Mode

Figure 2.2.4 “Lighter” setup of the La-5 model — more objects are on the invisible layers

Clicking with the “cells” of the layer control (see Figure 2.2.4), you can flip their visibility (white = invisible).
Always do it holding down the key. If you forget it, clicking into one layer will turn off the visibility of all the

others?.

What are layers in a program like Blender? Their name comes from 2D systems. You already encountered them
in GIMP (in Volume |, for example). In 3D programs layers lost their analogy to the surfaces that can be stacked
on each other?. They remained in the role of object groups that you can quickly hide or show. | often use this
feature, placing various elements of the aircraft on different layers. Typically, while modeling a new part, | work
on one or two layers, which contain all the required objects. For example — modeling the fairing between the
wing and fuselage, | used three layers: one for the wings, one for the fuselage, and one for the fairing itself.
(That is: the modeled object and the elements it has to fit between).

Blender offers us 20 layers. Treat them as “containers”, in which you can keep the related objects (I will describe
on page 242 how to do it)3.

1 In such a case call the Undo command — -, or (in this mode) Object-2Undo. It restores the layer visibility to the state before this
ill-fated click!

2 In three dimensional space it is difficult to talk about layers that contain spatial objects, unless you are able to imagine them in the fourth
dimension. In this case, | congratulate and envy you ©!

3 Frankly speaking, on the completion of this La-5 model, the number of 20 layers was a bit too small. | succeeded, however, in the end, to
cram all its elements into these 20 "containers" in a more or less orderly manner. A detailed description of the La-5 model structure, includ-
ing its layers, can be found at http://airplanes3d.net/downloads-la5-intro_e.xml.
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It's time to view our model from various sides. Press the |1| key on the numeric pad (or select the View =Front

command) to see the front view (Figure 2.2.5):

Front Ortho

The plane of
this view: ZX

(1) 012.Body

@otjectMode v @ 5| © 5] Pl clobal ¥ | C

Figure 2.2.5 Front view (ZX) — shortcut: the |1|key

When you press the |3| key on the numpad (or invoke View Left from the menu) — you will see the left side
view (ZY — Figure 2.2.4). When you press the |7| key (or invoke View 2Top from the menu) — you will see the
top view (XY — Figure 2.2.6):

The plane of
this view: XY

{1) 012.Body

@objectMode + @ % @ +[&) M8 Gloa & | -

Figure 2.2.6 Top view (XY) — shortcut: the |7| key

To see the model from the opposite side (right, bottom, rear) use the same shortcut keys, but also hold down the
key:

- right side view: [ctri]{3] (View SRight);

- bottom view: [ctri}-7] (View 2Bottom);

- rear view: [ctri}-{1] (View DRear);

e  On the computers without the numpad, set the Emulate Numpad option (see page 32) and use the keys
with numbers, from the row located below the function keys (below the [F1].[F12)).
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Figure 2.2.6 does not display the entire airplane. To zoom it out, press the E| (minus/dash) numpad key, two or

three times (or invoke the View 2Navigation 2Zoom Out command, but it is less practical):

To zoom the view smoothly — holding
down m and move the
mouse up or down

(1) 012.Body
Figure 2.2.7 Zooming
Similarly, pressing the [+ | numpad key zooms it in (View 2View Navigation 2Zoom In). There is also a

shortcut. It sets up such a magnification that you can see all the scene objects in the active window.

You can also zoom using the mouse. Roughly — by rotating . (It invokes exactly the same commands as
the shortcuts). Precisely (smoothly) — holding down [Ctrl], press and drag the mouse up or down.

How to pan the view? Roughly — [ctri}-f8] or [ctri}-[2] (up or down), [ctrila] or [cirile] (left or right). It is not so diffi-
cult to remember — notice, that on the top of the , E| and 4| numpad keys you can see adequate arrows!
To pan precisely (smoothly) — holding down press and drag the mouse, so the view will follow this
movement (Figure 2.2.8). | always use the mouse to pan the view in Blender?!

To pan the view smoothly — holding

down and drag the

mouse. The view will follow this
movement.

(1) 012.Bady

Figure 2.2.8 Panning

1 Yet another method is a "jump" to specified point on the screen. You can use the 3D Cursor (see pages 55, 272) for this purpose, invoking

the View >Align View >Center View to Cursor command (-
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Finally — let’s rotate the view. Press and move the mouse cursor within the 3D View area. This will rotate

its viewpoint around the model. In the Figure 2.2.9 you can see the rules of this operation:

A
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.'i.

User Ortho

(1) 012 .Body

® Object Mode ¥

Blender Render | A

Hold down and drag the

mouse near the window edges to
rotate the view around the axis
perpendicular to the screen

Hold down and drag the mouse in

the middle of the window to rotate it around
horizontal axis (vertical movements) or
vertical axis (horizontal movements)

il a CERNE i
@ &, v &3] |PAY Global ¥ =

Figure 2.2.9 Rotating the view —the axis of this rotation depends on the mouse location inside the view area

The current rotation axis depends on the location of the mouse cursor. When you drag it through the area close
to the window edges — it will rotate the view around the axis perpendicular to the screen. When you move the
mouse cursor in the center of the window — the viewpoint will move on an imaginary sphere around the active
object. A horizontal shift causes rotation around vertical axis of this sphere, and a vertical shift — around its

horizontal axis.

It sounds a little complicated, but | suggest
playing with the view rotations for a moment
or two, to “feel” how it works. Sometimes
during rotation a part of the model can ap-
pear outside the window borders. In such a
case, move it (shiftHVI¥:], see Figure

2.2.8) back to the center of the view.

Let’'s look carefully at Figure 2.2.10. Is this
plane proportional? The left wing, located
closer to the viewpoint, seems to be smaller
than the more distant right one... Not sur-
prisingly, because we can see this airplane
in the axonometric (orthogonal) projection!
(It is a projection, where two parallel lines in
space are also parallel on the screen).

The left wing seems
to be smaller than the
right one !

Engine cowlingf, %
seems to be toof% ™
small...

Figure 2.2.10 “Distortions” of the axonometric view
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Photographs have accustomed us to the perspective projection — so let's turn it on. Just press the |5| numpad
key (View 2Persp/Ortho) — and here it is (Figure 2.2.11):

Blender Render ¥

(1) 012.Body
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© ObjectMode 4| @ % @ 4[5 PN Giobal 42"

Figure 2.2.11 Initial perspective projection (with a strong “fisheye” distortion)

Well, it seems that the perspective distortion is too strong in this case (Figure 2.2.11) — this airplane looks like
through a wide-angle lens! Can we do something with it?

Sure! Press the E key (View 2Properties) to open the Properties shelf (Figure 2.2.12a). If the Blender controls

visible in this pane looks a little bit strange for you — take a look at page 64, where they are described.

Press E to open this
toolbox
L i The View panel

* vooo0 *E contains properties| |
4 Z:-0.01575 " M| T of this 3D View

A
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I
5] 5] 5]
< || B B B

Y -0°
These are the active <« zZ:0°

XYZ Euler

-

HE

L
acdede

I'5a

Scroll  the toolbox
down

+|

Figure 2.2.12 The Properties toolbox and its View panel

At the top of Properties pane you can see the Transform section (panel). It displays some of active object prop-
erties (you will learn in the next section what the “active object” is). We do not need them at this moment. Below
there are more, initially invisible, panels. Move the slider of this shelf down to see the View panel (Figure
2.2.12b). (When necessary, you can reorder panels of this toolbox, so that View will appear on its top — see
page. 61).
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The View pane contains properties of the current projection. Increase its Lens value from 35 to 70 units. (Lens
is an numeric field — in case of doubts on how to use it, take a look at page 66). With such longer lens the air-
plane is less distorted, but it appears too close, so you can see only a part of this model. Zoom it out a little —
using the E numpad key or scrolling the . Figure 2.2.13 shows the result:

' Lens: 70.000 "

the lens to
70

* Start: 0.010*
< End: 500.000

.
The inner faces "break through" —

from underneath of the model -
surface

X -17.7485 ¢
AR -52.4280 ¢

7 -3.0099»

| r N Rrh
© ObjectMode +| @ 3|t IN ciotal  * |30 5laonn X @) &2 % FE)

Figure 2.2.13 Adjusted perspective view (with increased Lens value)

Notice the “penetrations” that have appeared on the model surface. These are faces of the interior objects,
which in the real world would lie 1 - 2mm (0.05 - 0.1 inch) below the surface of the airplane. (This is the thick-
ness of sheet metal or plywood sheathing). They were not visible in the axonometric projection, and will disap-
pear when you zoom in the view. Yet this effect is very ugly. How to get rid of it?

It turns out that it is enough to change another property in the View panel. When you increase the Clip:Start
value (for example to 0.1), the “penetrations” of the inner faces will disappear (Figure 2.2.14):

<E] Back to Previous Blender Render | A

‘\\ .  Lens: 70.000 ¢

Increase
the Start
value

7

-3.0099 »

(A 012Rake | %
® ObjectMode 4| @ 3| =) 4 (BN ciobal ¢ [958 a0aa0 @& ¢ | BFE

Figure 2.2.14 Adjusted perspective view — increased the Clip:Start value

(The previous Clip:Start value was ten times lower — see it in Figure 2.2.13).
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If you want to return to the axonometric (orthogonal) projection — press the |5| numpad key again (it acts like a
switch). You can also invoke the View 2Persp/Ortho menu command.

In the perspective view you may encounter a phenomenon which | call “invisible wall”. To see what | mean, try to
zoom in the pilot cockpit (Figure 2.2.15):

@ But at some point you cannot
get closer anymore!

(1) 012.Body (1) 012.Body

Figure 2.2.15 The “invisible wall” effect during zooming (perspective projection)

Set this part of the model in the middle of the 3D View window and start to rotate forward (Figure 2.2.15a).

Initially, you will have an impression that you are rapidly approaching the model. However, gradually this move-
ment is becoming more and more slower. Finally you will reach the state, in which any further rotation of

changes nothing (Figure 2.2.15c). What's more, you cannot pan this view (shift-EEY]) either!

What is the reason for such a strange effect? Well, in perspective projection each view has its focal point, locat-
ed at a distance from the screen plane. Zooming in the perspective view reduces this distance (Figure 2.2.16):

S 0 N ~
1150 T N 0 AV -
Sy P BELEEES o 1l i T |
The “invisible wall” ‘ ‘ = - 4 ‘
is near here > Al .
'\ | | x
,i.‘,.‘, | [ ez \___, View lens:
; - 70 mm
\ [ i.e. 25.75°
— - \ The view
i J The view plane (a)
focal point
uy ] : ! adl \ Locations of the view plane,
corresponding  subsequent
1 rotations of the [V
Z1 |
| | vl . | = .

Figure 2.2.16 The reason of the “invisible wall” effect

When you rotate the forward (or press the |+| key on the numeric keypad) Blender reduces the distance

between the observer and the focus by the /s of its current length. This means that the closer you are to that
point, the slower you are moving, and finally you will stuck on a distance close to zero (as in Figure 2.2.15c).
Unfortunately, Blender does not offer any direct command to shift the focal point of a perspective view into a
new, more distant location!
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Fortunately, we can move the view focus in an indirect way. When you encounter the “invisible wall” during
zooming, go back a little bit (i.e. decrease the magnification, for example by pressing the E] key several times) to
increase the current distance from the screen to its focal point. When you are able again to pan the screen with
ease, press — (View 2Navigation 2Walk Navigation — Figure 2.2.17a):

...then press
o

. complete this
a 0 Hold down the ... release operation

in the
of key... L when you are
> close enough...

y
In the Walk Navigation the
mode move around the movement faster,
scene using the same rotate once
keys as in games:

... the view begins to move ... and finally you are
toward the center ... where you want, and the
- view is not locked!

Figure 2.2.17 Using Walk Navigation to shift the current view and its focus

In this mode you can move around Blender scene as in games: press |w| to move forward, |S| to move back,
— to the left, EI — to the right. Move the mouse to “rotate your head”, determining the view direction. Thus to
pass through the “invisible wall” of a perspective, keep pressing the key to move the focal point along the
axis perpendicular to the current view plane. To accelerate this movement you can rotate the once or twice.
When you are close enough to the desired object — click to complete this operation (to confirm this new
projection). If something went wrong — you can always press to cancel it. This is the quickest way to over-

come the “invisible wall” effect. (That's why you had to move the view back a little, before — to create a suffi-
cient distance before this operation).

You can find all the commands we have discussed in this section in the View 2Navigation submenu. If you can’t
remember their keyboard shortcuts, you can use the contents of this menu as the hint (Figure 2.2.18):

-

Toggle Quad View Ctrl AltQ Orbit Down Numpad 2

Duplicate Area into New Window _
Roll Left Shift Numpad 4

Playback Animation AltA Roll Right Shift Numpad 6 §

View All Home Pan Left Ctrl Numpad 4 —
View Selected Numpad .

View Global/Local Numpad / Pan Up Ctrl Numpad 8 f * Start: 0.100 *
e / « End: i
Show All Layers 3 Pan Down Ctrl Numpad 2 ; End 500.000 *

Pan Right Ctrl Numpad 6 S i

Render Border... Zoom In Numpad + / O Camera.Tracked X4

Zoom Border...

Clipping Border...

Fly Navigation
™ Walk Navigation

X / X 20.9762 *
View Persp/Ortho Numpad 5 4
. 3 / z - “Y: 108.7653 *
<Z: :

Cameras E 0.0000 »

Left Ctrl Numpad 3 ——
Right Numpad 3 =

Back Ctrl Numpad 1 4 (4 | 000.Pilot

Front Numpad 1 [ | —_—
Bottom Ctrl Numpad 7

Top Numpad 7
Camera Numpad 0

B Tool Shelf
B Properties

Figure 2.2.18 Commands from the View menu
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Summary

e Elements of a complex model are placed on different layers. Switching these layers on and off, you can
quickly control the visibility of the objects you want to work with (page 38);

e To quickly set one of the orthogonal views, use following shortcuts: [1] (front), [3] (left side), [7] (top). To view

the scene from the opposite direction — hold down also the key: [ctri{1] (rear), [curi}-[3] (right side),
|ctril-7] (bottom) (page 39);

e To rotate the view: drag the mouse with the m pressed (page 41);

e To pan the view: holding down the key, drag the mouse with the m pressed (page 40);

e To zoom the view: holding down the @ key, drag the mouse up or down with m pressed (page 40);

e  Switching the current projection between the axonometric and perspective: use the ]El key (page 42);

e You can change the projection parameters (for example — the lens of the perspective projection) in the
Properties pane (N]), on the View panel (page 43);

e When you zoom in the model in a perspective view, you can come across the “invisible wall” effect (page
44). Use the Walk Navigation -) command to overcome this issue (page 45).
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2.3 3D View — cameras and object selection

There are more ways to view the model than we have discussed in the previous section. To see another one,
press the |§| (“zero”) key (View =2Camera):

The border of the
rendered area

(1) 012.Body

© Object Mode = <) PN Global %
Figure 2.3.1 Camera View

Figure 2.3.1 shows the view from the active camera. Blender will use this projection to create the final render or
animation.

What is a camera in Blender? It is a special kind of object, which you can insert into the scene. This La-5F sce-
ne contains two cameras. Press |1 and adjust the zoom, to see both of them (Figure 2.3.2):

A camera, name:
Camera.Static

A camera, name:
Camera.Tracked

| have zoomed this camera object, so you can see its
details. In most projections it is so small that almost
reduced to a point.

(1) 012.Body

@ Object Mode - | PN Global %

Figure 2.3.2 Two cameras of the La-5 scene
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You can move these cameras — just like in a real studio. Before we start doing it (page 51), we will learn how to
select objects. It is the first step of every Blender operation.

Click the onto the right camera. In response Blender highlights it (Figure 2.3.3):

Blender Render ¥ D

Click it with -

The clicked object has
become pale pink

Active object name. (The last “clicked” one).
In parentheses — the number of its layer.

(1) Camera.Tracked

) Object Mode ) 55 PN Global 4

Figure 2.3.3 Selected object (a camera)

The selected object has changed its color to pale pink. This way Blender marks the last “clicked” scene element.
You can see its name in the lower left corner of the 3D View. This is the current active object. (The active ob-
ject is the last selected object).

Press the E key (Select>Select/Deselect All) now to deselect everything. (This command “clears” current

selection, when it exists, or selects everything, when nothing is selected). Notice that the active object name is
still on the screen (Figure 2.3.4):

Blender Render ¥ D

This object is no longer selected, but it
is still the active one.

Its name is still visible in the lower left
corner of the window, and the origin of
this object is still highlighted

{1} Camera.Tracked

® Object Mode » e PN Global %

Figure 2.3.4 The last selected object remains active

The active object plays important role in many Blender operations — for example in the Parent command, which
creates the object hierarchy (see page 306).
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To include an additional object to the current selection set, hold down the key while clicking objects with

the [FIYE. In order to better learn how it works, | suggest you make a few quick experiments.

Start them when nothing is selected. Hold down the key and execute the sequence of operations listed by

Table 2.3.1. (You can find the camera names on page 47, Figure 2.3.2):

Holding down the Iﬂl key: Result
Selected objects and their colors Active object

Click with into Camera.Static Camera.Static (pale pink) Camera.Static

Click with into Camera.Tracked Camera.Static (pink) Camera.Tracked
Camera.Tracked (pale pink)

Click with into Camera.Static Camera.Static (pale pink) Camera.Static
Camera.Tracked (pink)

Click with into Camera.Static Camera.Tracked (pink) Camera.Static

Table 2.3.1 The active object and the selected object — some experiments with the group selection in Blender

I will not show the results of the operations listed in Table 2.3.1 on the pictures. The standard adjustments of
their contrast and brightness cause the loss of subtle differences between the two colors of the selection: the
pale pink (active object) and the pink (other selected objects). The conclusion of these experiments is as fol-
lows:

- The key modifier serves not only to include, but also to exclude an object from the current selec-
tion set. (When you click an object for the second time, it becomes the active one, and when you do it
for the third time — it is no longer selected);

- The active object can be out of the current selection (see the last row in Table 2.3.1);

You can also select a group of the objects using a rectangular area. Press the shortcut (Select >Border
Select). In this mode two crosshair lines appear at the mouse cursor. Move the cursor to the place where you
want to have the first corner of the selection area. Press the and hold it down while dragging the mouse
(Figure 2.3.5). It will drag the opposite corner of the selection rectangle. Locate it in the proper place, and re-
lease the . It selects all the objects that are inside this area (also the ones that lie across its borders).
Border Select command does not alter the current active object.

Press

...drag the mouse...

...and release .

Figure 2.3.5 Selecting objects with the rectangle (Border Select)

To exclude the objects inside this rectangle from the current selection, after invoking Border Select command

(the [8] key) use instead of [lff].
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The Select menu of 3D View window contains many other commands, such as selection by the layer, or by the
object type (Figure 2.3.6):

Dy ] Back to Previous Blender Render ¥

Mesh : « Start 0.100 ¢
Curve ¥ 4 < End 500.000

Surface

Meta [d CameraTracked 83

Font

-
"'(. Armature

Lattice
Select Pattern... -

Linked Shift L Empty % 20.9762 1

Grouped Shift G e o TOSH55F
i i 0.0000

Select Camera Lamp

Speaker

Select All by Lka‘,rer
Mirror Shift Ctrl M

Random

Circle Select
Border Select

@ Object Mode 2= B Global

Figure 2.3.6 Other selection commands, available in the Select menu.

e You can find description of few other useful selection methods on page 322.

Summary

e To display the view from the active camera in current window — press the @ key (View 2>Camera) (page
a7);

e To select an object, click it with . Hold down the key, to add it to the previously selected objects
(page 48);

e To select objects using a rectangle — press the shortcut (or invoke the Select2>Border Select com-
mand). Then press the in the first corner of the rectangle, and drag the mouse to set the opposite cor-
ner. To exclude objects from the current selection — begin in the same way (, but use the m instead
of the (page 49);

e Blender distinguishes the last clicked (with the ) object from the rest of selection. It is referred as the
active object, and its name is displayed in the lower left corner of the 3D View window (page 48);
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2.4 3D View — object movement and rotation

In this section | will show how to change the location and orientation of the active camera (it is also an object).
However, before that:
- select the Camera.Tracked object. It is the active camera of this La-5 scene. Make sure that you can
see its name in the lower left corner of the 3D View window;
- tile the active 3D View - E] or Area Options 2Tile Window), and join two other windows, leaving
just two views on the screen. In one of them set up the camera view (|§|), in another — the front view

(Figure 2.4.1). We will work in the left window, simultaneously observing changes in the right one:

m_T? Blender Render ¥ D

Selected camera

The name of the camera
(1} Camera. Tracked (1) Camera.Tracked

©ohjectMode v | @ 3| © T QobjectMode 5 @ 3| ¢

Figure 2.4.1 Screen layout, proposed for this section

Press the key (or Object >Transform 2Grab/Move). From now every movement of the mouse moves the

selected object (the camera, in this case). Notice the changes in the camera view window (Figure 2.4.2):

m_T? Blender Render ¥ D

Move the camera
object...

. so the view

from this camera

Current displacement vector and dynamically
| e 200 - |the distance (in parentheses). changes!

Figure 2.4.2 Moving the object

During this operation Blender shows in the active 3D View window header current X,Y,Z coordinates and the
length (in parentheses) of the offset vector. Click to accept current location of the object, and finish this

movement. (To cancel this operation, press the key).
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How does it happen that during this movement the camera is keeping the aircraft in the center of its view? Be-
cause it is tracking this model. | will describe how to create such a link later in this book. Now | would like to
demonstrate what is actually tracked by this camera.

To show this “target” object, we have to hide some
layers, and enable the others. However, you may
encounter a problem (at least on the smaller dis-
plays): there is no visible layer indicator on the 3D
View window headers! Each pane in this tiled
screen layout is so narrow that this control is hid-
den somewhere beyond the window edge.

Little secret: you can move the window headers in

Blender, just like you pan the 3D View scene. Just i e oiting down the m drag the

place the mouse cursor over a header, and press oo/ JImouse over the window header —
. . . /| this will move it left or right

[YIYE. Holding it down, drag the mouse left or right. ) -

Can you see that the entire header is moving? Shift
it to the left, to make the layer control visible

I - 1 D R e OO

(Figure 2.4.3). Figure 2.4.3 Shifting the window header

Now turn off layer 11 and turn on layer 10. Oh, | have to introduce the concept of layer numbering! To keep the
explanation short, let's assign to each layer the following numbers (Figure 2.4.4):

(12345](678910]
(11]12|13]14]15] L16 171819 20J

Figure 2.4.4 Numbers assigned to Blender layers

Thus flipping the states of layers 11 and 10 gives following layer visibility: B8, Turning off layer 11 hides
the wings and the middle and rear part of the fuselage. Layer 10 is one of the two layers that contains the auxil-
iary “control” objects, not intended to appear on the final render. (Another layer in this scene that groups such
objects is layer 9). Now you can see in the place of the invisible wings of our model the slots, ailerons and flaps,
and in the place of invisible tail plane — its rudder and elevators (Figure 2.4.5):

Blender Render ¥

This is the armature
(“bones”) used for the
animation of the pilot
figure. (It is one of the e -
objects from layer 10)

The focal object of the
camera — Camera.Target

_____________________________________________

@objectMode % < 45 PN Global Bl Rl

A
-

Figure 2.4.5 The Camera.Target object — the focal point of our camera

Somewhere in the cockpit area there is a relatively large, red cylinder. It is named Camera.Target. Select it (see
Figure 2.4.5).
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Let's say that we would like focus our camera on the engine area instead of the cockpit. To place it there, you
have to move the Camera.Target object along the Y axis. You can do it in any view projection, even in the per-
spective.

Press the |G| key to shift the selected object. Immediately afterwards press the |y| key — it restricts the current

movement to this axis. The Y axis has become white, and the information displayed in the window header is
different — it shows a value of the single Y coordinate. Now, every mouse movement shifts this object along the
Y axis as on a wire (Figure 2.4.6):

Shifted object

The path of this movement
— the global Y axis.

{1} Camera.Target

9 Object Mode

Figure 2.4.6 Constrained object movement (along the Y axis)
As you can see, the camera keeps the Camera.Target object in the center of the window. Do not end this
movement yet. | will show you another effect: while dragging the mouse, hold down the key. Do a relatively

long move. Now you will see that the object is moving in steps of 10 units (Figure 2.4.7):

Hold down the key during

this operation, to move the object
in fixed steps of regular length

Figure 2.4.7 Moving the object by regular steps (holding down the key)

e Holding down the |Cl'| key during every transformation (moving, rotating, scaling) changes the values being

transformed stepwise, by a fixed increment.

(I have shown the key in action during the shifting of an object along Y axis just as an example. You can

use it in any transformation).
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Why does the basic “step” of the object movement in this window have a length of 10 units? It depends on two
factors: the current magnification and the 3D View projection. Cancel the current operation () and start it
again but in the left side view (the lower left window depicted in Figure 2.4.7). When you hold down the key
here, the basic step of the object movement will have length of 5 units — two times less, than in the perspective
view. It seems to be a general rule — in 3D Views with the “orthogonal” projection (from the top, side, or the
front..) these steps are smaller. This is the approximate distance between the nodes of the helper grid, which is
displayed by the 3D View. When you zoom in the view, its grid is getting denser. Simultaneously the basic
movement step forced by the key decreases, respectively, from 5 to 1 unit.

Now another effect: hold down the key while dragging this camera. What happens? The same mouse

movement causes a smaller displacement of the dragged object!

e Holding down the key during every transformation (moving, rotating, scaling) reduces the “influence”

of the mouse. (The same mouse movements cause smaller object displacements on the screen). It makes
easier to set precisely the object onto its final place.

What happens when you hold down the and keys simultaneously? We will obtain a stepwise move-
ment that has its basic step ten times smaller. In the camera view it decreases the basic translation step from 10

units (the key down, only), to 1 unit (both and keys down).

I would like to show the object rotation with an example in the side view. Yet there is a small problem — the
object to be rotated is obscured by the wing flap. Let's say that you do not want to turn off the visibility of the
layer containing that flap, because you would miss the contour of the wing trailing edge in this way. In such a
case you can alter the way in which Blender draws the contents of this window, switching it from the Solid to the
Wireframe mode. Select the Wireframe as the current drawing mode from the Viewport Shading dropdown list.
It is located on the 3D View window header (Figure 2.4.8):

This object in the}

. 1
current shading mode i
(Solid) is obscured by
the wing flap... i

T
I
I

+
1
|
I
I
|
|
|
|
|
|
|
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v
v

.50 let's switch into
Wireframe shading mode!

Viewport Shading
3 Textured ’
z z

|
| o @ sulid
n

:.: Bounding Box

LI © view seect Object ® i) = +EJIIN Ot )| @onecivoe &

Figure 2.4.8 Changing the Viewport Shading mode

¥

]

Figure 2.4.9 shows the result of changing the shading mode. As you can see, it is an individual setting of each
window. (The right window still uses the Solid shading on this illustration).

In practice, the Solid and Wireframe modes are used most often. The third method of shading (Textured) will be
used later in this book — when we deal with textures.
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How to rotate an object? In a similar way to object movement: press the |E]| key (Object 2Transform =>Rotate)

to start the rotation (Figure 2.4.9):
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[ ) Henderory 259
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|
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Figure 2.4.9 Rotation (around the origin of selected object)
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(1} Camera.Tam

By default, the object is rotated on the current screen plane. The window header shows the current rotation
angle. You can also force the rotation around any of the X, Y, Z axis, by pressing one of these keys on the key-
board ([x], [v], or [z)).

The rotation of the Camera.Target object also rotates the camera (see the right window). This follows from the
fact that the camera is “tracking” this object, so the local Z-axis of the camera points always in the same direc-

tion as the local Z-axis of Camera.Target. You can also use the [smft] key while rotating, to obtain a precise
rotation, by fractions of a degree. Use the [Ctrl| key to rotate by angle increments of 5°, and [shift}-[Ctrl] to rotate

by increments of 1°.

If you want to rotate around other point than the origin of
selected object, you have to u§e the 3D .Cursor. | ‘3_D|cu_rslor_|1—
You know the role of the flashing caret in any text editor. It —|—|—|J
shows the place where the new text will be inserted, if you

/",'

start to type. This concept was copied into the 3D world. In A
Blender there is also such a special point, which you can T
place anywhere in the scene. They also named it cursor, -
but with the 3D prefix. It marks the location where the new P
. . . . . &
object will be place(-j, if yo.u c.reate it at this -moment. It c.an %ﬁ,ﬂ"‘ : :
also serve as the pivot point in such operations as rotation : [ ]
or Scalmg' You can use the SnapL I i
menu  commands  to u |

3D cursor is drawn as a small cross, surrounded by the z precisely place the 3D jAgy

) . . . Cursor in the scene space [
red and white circle (Figure 2.4.10). You can put it any- | | | T T T T ] -

i )

where, clicking the in the desired place of the scene. @ e ok 'ow'm m-
Select " Obj e v

You can also force it to move to the nearest grid point. To
do this, press the [shiftl-[s| shortcut (Object to Snap) and

b B

Figure 2.4.10 3D Cursor and the Snap context menu
from the menu that appears, select the Cursor to Grid command (Figure 2.4.10).
This second step — selection of the menu item — you can do also with the left hand, pressing the EH key. (The

“6” is the position of the Cursor to Grid command in the Snap menu, counting from the top).
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To rotate the Camera.Target around any spatial point, place the 3D Cursor (with a click) in appropriate
point on the screen. (You will often have to set its location in two perpendicular views. The Snap menu com-
mands are also helpful in such a case).

Then switch Blender into the mode that uses the 3D Cursor as the reference point. To do it, use the Pivot
dropdown, from the 3D View window header (Figure 2.4.11). Select the 3D Cursor option from this list (or press
[] on the keyboard):

2-Model

Pivot Point

'@ Active Elerment
L

. @ Median Point
. 17
£ Camera.Target is T —— €5 Individual Origins
(ot selected - 2> 3D Cursor . 2. From the Pivot Point list

select the 3D Cursor

:“: Bounding Boo
@ objectMode ¥ | @ 5 &) SRS PN

= R

Figure 2.4.11 Changing the Pivot mode to 3D Cursor

Make sure that the Camera.Target object is still selected.

The remaining steps are the same as before — press the I[Eﬂ key and rotate the object (Figure 2.4.12):

2-Model
The center of i by
this rotation is + .
in the 3D A
Cursor point '\ 4 .y
y .
i e iy v _g ll:_-’ﬂ
‘\ T
¥ . =
amera.Target — /
the rotated object | =——

Figure 2.4.12 Rotation around the 3D Cursor point

When you finish, set the Pivot Point back to the Bounding Box Center mode (][]). Alternatively, you can also

switch it into the Individual Centers mode (@H:]).
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I will not describe here the last one of the three basic object transformations: scaling. So far | have tried to dis-
cuss each topic in a way that allows you to immediately use the acquired knowledge. For example, by rotating
and moving Camera.Target and Camera.Tracked objects you can arrange for the render a new projection of
the La-5 model. (I will introduce rendering in the next section). Unfortunately | did not find in this scene and at
this point of narration any useful application of scaling. | will only mention that changing an object size is very
similar to the rotation. The reference point is also determined by the Pivot Point mode. It can be the object origin
or 3D cursor. To start the scaling operation, press the |s| key (Object 2Transform =2Scale). More on this sub-

ject you can find on page 291.

If you want to type exact numerical values of ob- =1 1 7 |

ject transformation instead of using the mouse, @; >

press the key to open the Properties pane . « x-0467 || H
(View 2Properties). On its Transform panel | S E0 R e
(Figure 2.4.12) you can find the current Location : : = (B
coordinates, Rotation angles and Scale coeffi- SN =, 7 < X153 A &
cients of the active object. If you rotate the active 1 5 : :2 : %
object with the mouse, Blender will update the - o N / g\g;;':rtiogect

values displayed in this panel “on the fly”. It also .

works in the opposite: when you enter a new val- ! + x:1o000  r |75
ue into one of the Transform panel fields, you will . :112‘;2 %
immediately see the effect of this change in all 3D i :

View windows. : 1) Camera Tage E ] ‘ X:1.932 ,

Note that each of the transformation fields has a
lock icon (=) in the Properties pane. When its is
clicked — the coordinate of this field is excluded from the changes applied during object transformations. It is
very convenient when you want to resize an object only in the one plane — let's say XZ. Before this operation

Figure 2.4.13 Properties of the active object

lock the Dimensions:Y or Scale:Y field. Then, when you start the scaling operation (, which usually resizes

everything uniformly in all directions, the object size along the Y axis will remain unchanged.

During transformation (rotation, translation, scaling ...), you can also enter exact numerical values of their pa-
rameters. Just press the El key (Figure 2.4.14):

| o s s ]
J E /You can also enable this | . !
\ !mode by typing (entering)| k
W I any digit on the keyboard | ne
Blender displays here ‘\ | __>_I,,9 ,,,,,,,,,, Y,__ __} _ | A vertical caret appeared in the first of
parameters of the | /_ the parameters — here you can enter
current transformation [ 717\ ,\ I_ an exact value of the Dx.

Figure 2.4.14 Switching into manual entering of transformation input values

Blender places a text caret in the first field of the transformation parameters. Now you can enter a new value
typing it on the keyboard. To shift caret to the next field, press (Figure 2.4.15). Press to complete this

transformation, or to cancel it.

You can see the entered value here. It
is also possible to enter a Python
expression, e.g. “1-cos(3*pi/180)”

In these parentheses
Blender displays the length
of the current displacement

To move to the next transformation Here you can enter an exact

value of the Dy

field, press

Figure 2.4.15 Entering exact numeric values of the transformation parameters
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In the Properties pane you can also check or
change the exact coordinates of the 3D Cursor.
Just scroll the content of this toolbox upward to
expose the 3D Cursor panel. Then inspect or
update its Location values (Figure 2.4.16):

500.000 > |

| | [d CameraTracked 23

Finally, let's talk about what to do when you have =i * JGurrent 3D Cursor| &
made a mistake and you want to revert your sce- ‘g%‘ A coordinates =
ne to the state before the last operation. Like the
most editors, Blender provides multiple Undo and
Redo levels. These two operations are so im-
portant that | have put their shortcuts in the boxes | = -

below. (To make them more visible when some- | | [ 1] .' [ T
thing has gone wrong in your Blender scene). ! b

0.0000 *
26.0000
40000+

Figure 2.4.16 View properties: 3D Cursor location

e Undo - reverting the last operation: press the — keys (or invoke the Object 2Undo command).

e  Redo - reverting the last Undo: press the [ctri[{shift}{z] keys (or invoke the Object >Redo command).

It is worth mentioning that the Object menu is present on the 3D View header only in the Object Mode, which we
are currently using. There are also other modes, like the Edit Mode (edition of a single mesh), which we will
discuss later. In these other modes you will find different menus on the 3D View header, in place of the Object
menu (for example — Mesh, in the Edit Mode). In each of them there are Undo and Redo commands. Yet it is
better to remember their keyboard shortcuts. In some other editors, like UV/Edit Image, you will not find these
commands in the Image menu, nor in any other menu. (It seems to be an error in the user interface design).
Nevertheless the Undo and Redo are still available there — you have to invoke them using their shortcuts.

Our introduction to Blender fundamental transformations ends here. There are obviously many other transfor-
mations in this program — as you can see in the Object menu (Figure 2.4.17):

Track GrabMove

Parent Eotats

Make Single User
Make l... To Sphere Shift Alt S
Make Dupli-Face Shear Shift Ctrl Alt S
Make Links Ctrl L » Bend Shift W
Ctrl Alt P Push/Puil
. X Mary
Duplicate Linked AltD ndary

ORI ER S Sl Move Texture Space Shift T
Animation Scale Texture Space Shift Alt T

Snap Align to Transform Orientation

Apply Geometry to Origin

= Origin to Ge
Mirror

Crigin to 3D Cursor

e F e T

Figure 2.4.17 Transformations available in the Object menu

Do not worry about the operations which have unfamiliar names. We will not need many of these commands to
build our model! I will introduce all the tools that | use in the following chapters of this book.
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Summary

Translation — the |G| key (Grab/Move — page 51);

Rotation — the [R] key (Rotate — page 55, 56);

Scaling — the |E| key (Scale — page 57);

Hold down IIE during transformation, to change object coordinates in the regular, fixed steps (page 53);
Hold down [shift| during transformation for the additional precision of the mouse (page 54);

You can restrict every transformation to a single axis, by pressing the [x|, [v], or [z] key (page 53). It allows
you to use these transformations even in the perspective view! Note: when you press the axis letter twice,
the movement will be restricted to the local object axis. Pressing such a key for the third time switches
Blender back to the free movement on the current view plane.

You can set the pivot point, used in rotation and scaling, to: ][:][ = 3D Cursor, ][] = Bounding Box (page 56);
To cancel current operation — press ﬂgj (page 51, 54)

To Undo the last operation — @Hﬂ (page 58).

To Redo the last Undo operation — @HEHZH (page 58);
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25 Properties window

At the end of this chapter | would like to show you how to obtain the final effect — a rendered image of the La-5
airplane. To do it, you will need to click some buttons, and switch some options in the Properties window. This
window is located by default on the right side of the Blender screen (Figure 2.5.1):

Context (the panel set) selection |

Current
datablock

A single panel

{1} Carmera.Static
Render Presets

‘4 K:1280
4oy1024 v

SESTITIR | custom izt 4
« v1000 * )| FPs13 »

>

(1} Camera_Static (1} Camera.Static

Pil= © Object Mode ® Object Mode
Figure 2.5.1 Main elements of the Properties window

In this window Blender exposes properties of the current scene, active object, its material and textures, etc. At
first glance, it teems with checkboxes, buttons, and other controls. | will start by explaining its key concepts and
elements. In the header of this window you can see the context (panel set) selector. Below you can see the
current datablock (see page 393 to learn what the datablock is) — this is the name of the “thing” that owns the
properties displayed below. (In the example, shown in Figure 2.5.1, this is the current scene, named Airborne).
Below you can see panels that group the controls by their “subject” (Render, Layers, Dimensions, ... — Figure
25.1).

On the top of each panel there is the header with the label (panel name). On the left side of the header you can
see a triangle that folds and unfolds the panel (Figure 2.5.2):

Panel header Click [B\YI=} here to

O unfold collapsed panel
Click [BVIEY here Render Presets Ol s =]
to fold (collapse) - =
the panel B Box v

¢ Yl.000

CEESTTER | cusom (13 o) *

< nrlo000

Fixed

Figure 2.5.2 Folding and unfolding the panel
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On the right side of the panel header there is a handle. You can “grab” it with and drag this panel into an-
other place (Figure 2.5.5):

"
Box -

“Gra is handle ‘
drag it into another place... : | H

v

= RGBA | | ¥ Overwrite
BWA RGBA | || Overwrite : :

frendersia-5 _ :
@ jreG v
BW RGBA | | ¥| Overwrite

“Passed” panels dynamically “jump” below

Figure 2.5.3 Moving the panel

The positions of all panels (and in general — the whole state of the user interface) are saved together with the
scene state in the Blender file. (When you open a Blender file, everything on its screen will look exactly as in the
moment of the last invocation of the File 2Save command. It is very convenient).

In many contexts the panel stack is longer than height of the screen. To reach the panels located below, you
have to scroll the content of the Properties window. Do it with the slider (Figure 2.5.4a), placed at the right edge
of this window, or just holding down the and dragging the mouse up or down (Figure 2.5.4b):

Box v

Move the =55
window slider [
U

Hold down

Fixed and drag the mouse
vertically

Figure 2.5.4 Two methods of scrolling the contents of the Properties window
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The Properties window has so many panels that it is virtually impossible to use them all at the same time (You
would have to scroll the window up and down too often). Fortunately you do not have to do it in this way. You
need different panels for modeling, others for working with materials and lighting, yet others — to render a sin-
gle image or animation. That’'s why the panels in the Properties window are divided into several sets (contexts),
corresponding to these typical operations. Use the icon buttons, located on the window header, to switch be-
tween different panel sets (Figure 2.5.5):

a) |Render: generation of the final image or animation | b) Object Data: in this case — Material: ~ color,
Mesh properties shininess...

|Scene: details of the current scene | -
Texture: images of the

surface details

Modifiers: invertible changes
of the mesh shape

|World: environment settings (background, etc.) |

Particles:
Current smoke, fire, and
datablock: other effects

ozgody [/ ¥y

Current datablock:
scene (Airborne)

These sets depend on the
type of active object

Object: active object

TR ——— Phisics: smulation of the Contexts specific for the Mesh object
to pose objects or the physical ~ world  (gravity, (i.e. a geometric object)
camera (tracking its target) inertion, etc.).

Figure 2.5.5 Typical contexts of the Properties window

Figure 2.5.5 shows the typical combination of the panel sets. This is the header of the Properties window, dis-
played for a typical geometric object. Figure 2.5.5a) describes the panel sets that are always present in the
Properties header, regardless of the active object type. These are the first five sections from the left: Render,
Scene, Word, Object, Object Constraints, and one from the right: Physics. Figure 2.5.5b) enumerates sections
specific for an geometric object. (Such an object contains so called mesh — a datablock representing its sur-
face, built of faces, edges, and vertices).

By the way — note, that in Figure 2.5.5a) you can see a different datablock (the Airborne scene) than in Figure
2.5.5b). This is despite the fact that the active object on this scene was the same in both cases. (It was the
012.Body object). Try to select some other contexts, and you can see further differences (Figure 2.5.6):

Current datablock: scene

environment (World),
ﬂ containing the active object

Current datablock: the
active object (012.Body)

Figure 2.5.6 Current datablock depends on the selected context

When you select the Object context, Blender will display the active object as the current datablock (Figure
2.5.6a) — this time without the mesh (Figure 2.5.5b). When you select the World context, it displays the envi-
ronment datablock (named World) that contains the active object. For the same reason when you select the
Render context, you will see the datablock of the scene, that contains the active object (comp. Figure 2.5.5a).

e The panels in the Properties window always show details of the datablock| ‘ R
Use this ,pin” to

displayed below the window header. keep  displaying
this datablock
. . regardless of the
If you want to see properties of a particular datablock, regardless of the current current selection

active object selection, use the “pin” to attach it to the header (Figure 2.5.7). Just
click this icon to keep it in the Properties window all the time. To detach this data-
block, “unpin” it in the same way.

Figure 2.5.7 Datablock “pin”
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There are also other types of objects that do not contain the meshes: for example light sources (Lamps), or
cameras. Figure 2.5.8a) shows the panel sets displayed for a Lamp, and Figure 2.5.8b) — for a Camera:

Datablock:
Camera.Tracked.001

Figure 2.5.8 Various Object Data icons for different kinds of objects

As you can see, the Object Data set that has the “triangle” icon for the mesh objects (see Figure 2.5.5b), for the
lamp data displays a “sun” (Figure 2.5.8a). The camera icon in Figure 2.5.8b) also speaks for itself. Note that
neither the camera nor the lamp have the Particles and Material icons. The cameras do not have the Textures
icon, either (because they do not need them).

Table 2.5.1 provides a summary of panel sets which we will use in further chapters of this book:

Context Description
E All the render parameters. At the end of this section | will show it in action.
Render
H S Scene parameters, like the active camera, or an assignment of another scene as the background picture.
cene

The Handle Panel add-on that we will use to “pose” the model, also adds its panel to this section. (This
Blender plugin controls opening and retracting of the landing gear, flaps, movements of the rudder, eleva-
tor, and ailerons, etc.).

ﬂ World The parameters of the scene environment (for example the color or texture placed on the background, the
or intensity of the global, dispersed light, etc.)

n . Active object properties: current location, orientation, name, and many others (for example: assigned
Object layers)

Manages the object constrains. (You can assign a constraint to any object. For example — the
Camera.Tracked is directed automatically on the La-5 model, because it has a Track To constraint. This
constraint always directs selected camera axis onto the auxiliary Camera.Target object).

E Object Constraints

This section is displayed for geometric objects only (i.e. the objects that contain the mesh datablocks).
You can apply here some additional, “reversible” effects, like smoothing with subdivision surface, or bend-
ing along a curve

Modifiers

ﬂ E E Properties of the object “content”: the Mesh datablock for the geometric objects, the Lamp parameters for
- ' T a light source, or details of the Camera projection for a camera, or other datablock types (Curve, for ex-
Object Data
ample).
m Material General properties of the material datablock, assigned to a mesh or an object (its color and specularity,
ateria

transparency, and many other parameters)

T Managing the material textures. These are raster images, used to recreate minor irregularities in the
exture surface (rivets, screws, panel joints). They are also used to alter locally many other material properties -
like the color (camouflage, dirt). This context is used for the Blender renderer only.

;_+ . We will use this section at the end of the book to create some grass on the airfield.
2| Particles

Table 2.5.1 Short description of selected panel sets

If such terms as “material” or “texture” are abstract for you at this moment — do not worry, | will explain their
meaning in the further chapters. Table 2.5.1 is placed here just to let you know what to do when | write: “In the
Properties window, switch to the Material set”, or “switch to the Material context”. (It means the same).

© Witold Jaworski, 2009 - 2015.



64 Creating the Model

Excuse me if this introduction was a bit lengthy. | wanted to bring your attention to details of panel handling in
the Properties window. In fact, the generation of the final image or animation in Blender can be reduced to click-
ing a single button (in a moment | will show you which one). Before | do it, we will discuss some options of the
rendering process. On this occasion | will explain briefly some other details of Blender controls.

Switch into the Render context. Figure 2.5.9 with this example shows the basic types of GUI controls used in
Blender:

a) b)
comr faei Image @5 Animation
Full Screen Full Screen v
Render Presets
Numeric ~ field DVCPRO HD )
(standard) DVCPRO HD
HDTY 1080
Numeric field f I, N HDTV 720R
(slider) - < ~.___________IBlender shortens the YR Y ET
too long labels — make HDV 1080p

the Properties window
wider, to change this O:
into Old:

HDW NTSC 1080p

Checkbox

This checkbox
enables  this
whole panel

Radial (toggle)
buttons

—Inactive controls
are grayed out

L
v

HDV PAL 1080p
TV NTSC 16:9

TV PAL 16:9
TV PAL 4:3

* Size:0.750 *

Figure 2.5.9 Basic types of Blender controls

Command buttons (also known as operation buttons) are used to invoke a command (like Render:Image or
Render:Animation). Do you know that in the original Blender terminology each control is referred to as some
kind of a “button”? The origins of this tradition are lost in the darkness of history. | think that because of this no-
menclature the control labels are placed inside the text and numeric fields (see Figure 2.5.9a). You have to
adapt to this convention. Fortunately, the checkboxes (referred also as toggle buttons) do not adhere to this
stylel.

Below the label of the Dimensions panel there is a dropdown list (menu button) named Render Presets. You can
click it (with the , of course) and select one of the typical render formats (Figure 2.5.9b)2. On the other pan-
els you can see a few dropdown lists, used to select one of the possible options (e.g. the list of the
Render:Display modes). When the list of the alternatives is short enough, Blender uses toggle buttons, instead
of a dropdown (for example, to choose the number of samples in the Anti-Aliasing panel).

1 However their current shape is a relatively new modification, which appeared in Blender 2.5. In the previous versions they looked like
toggle buttons (highlighted when turned on). Thus the role of these controls was not so obvious, especially at first glance you could confuse
them with command buttons. The current checkboxes are more readable for new users, because they comply with the convention of popular
windowing systems.

2 Notice that when you select an item from the Render Presets list, the content of the Dimensions panel will change. The Resolution, Aspect
Ratio, Frame Range, Frame Rate fields will be updated according the settings from the selected item. You can also use the [+] button (on
the right side of this dropdown) to add a new item to this list. It will copy the parameters currently displayed in the panel. (I have not used it).

Virtual Airplane — third edition www.airplanes3d.net



Chapter 2 Introduction to Blender 3D 65

Sometimes the dropdown can have several columns. | will show it on another example. Scroll the panels of the
Render section slightly upward to reveal the Output panel, placed at the end of this panel set. It contains a
dropdown list where you can set the default file format for the rendered image (Figure 2.5.10):

-~
Box v

4 Size:0.750 ¢

Output BMP Cineon | AVI Codec

Jfanimationija-5 DDS DPX vl JPEG .
e The dropdown list
IPEG s 1B Iris MultiLayer I® AvI Raw can have more

BW RGBA | | ¥ Overwrite OpenEXR B Frame Server than one column!

| ™ | -
|PEG k Radiance HDR
) JPEG 2000 TIFF

Targa Ogg Theora
Targa Raw vid
IPEG 3

BW RGBA | ¥ Overwrite

Figure 2.5.10 Selection of the default raster image file format — an example of multi-column dropdown list

e The raster file format, set here, applies to all raster images, generated by Blender. Even the simple “dump”
of the current Blender screen ((Ctr{F3]) is saved in the format specified by this field!

When you select the Jpeg file format, you should also set the value specified by its Quality field (Figure 2.5.10).
The Jpeg format is one of the so-called destructive compression formats, because it reduces the file size at the
price of image quality. Using the Quality value (expressed as a percentage) you can control the compromise
between the file size and quality of the image. When Quality = 100%, there is no image degradation (each pixel
is stored separately). Such a file will have the largest size, of course. Personally, | advise to set the Quality value
to 85%-95%. Such a setting creates relatively small file that still contains a picture of a decent quality.

How to enter the new Quality value? Probably it is obvious for the most readers, but | will describe it here in a
few words. Perhaps you may learn some useful details this way.

The Output:Quality field is a slider, i.e. its values are restricted to a specific range (between 0% and 100%, in
this case). Blender fills the slider with two colors, where the border of these colors corresponds to the current
value. You can change the slider value dragging the mouse over it (with pressed — Figure 2.5.11):

Press over ...and drag it!

the slider...
ﬂﬂ::> Qi ju

Figure 2.5.11 Changing the value of a numerical field with the mouse

Of course, you can also change this field by typing an exact value. Just click it once (with the ) or press the
key, to let it receive the keyboard focus. Then you can type a number (Figure 2.5.12):

Click [8VI=] once, then type| | press ’ i.s..usggtggle field
the new value. . when it is finished...

>

Figure 2.5.12 Changing the value of a numerical field by typing

What is interesting — you can also type an arithmetic expression, like “100 / 3", and even something with
brackets! It works like a calculator, substituting the result as the new value of this numeric field.
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More often encountered is the version with “arrows”. Such a field may have unrestricted range of its values. In
the Dimensions:Resolution area you can find a group of three numeric fields, controlling the size of the ren-
dered image. The two upper ones — X and Y — are the standard “arrows” fields, determining the width and
height of the result image (in pixels)! (Figure 2.5.13):

Clicking  (&\%=5) on b)
these arrows, you can “ X:1280 »

a)

increment or decrement

You can also type
the value of this control P

it here

Figure 2.5.13 Two methods of changing the value of a numeric field

Clicking on the “arrows” on the left and right sides of a field, you can increment and decrement its value
(Figure 2.5.13a). Each click changes it by a fixed step (in this case — by 1 pixel). It is a good method for small
corrections, but if this box has to contain a completely different value — you better type it directly (as shown in
Figure 2.5.13b and Figure 2.5.12).

e To cancel current edit operation (in the situation as in Figure 2.5.13b), press the key.

You can use each numeric field as a slider, by dragging the mouse (holding down) over its area (see Fig-
ure 2.5.11). If you want to change it incrementally, by the fixed steps — hold down the key. (This is the

same convention as for the object transformations — see page 53, Figure 2.4.7). You can also use the mouse to
change simultaneously two or more related numeric fields (usually they are coordinates — Figure 2.5.14):

a) b) c)
Loz A
47 1 nnn e «z:be T 10000 .7z T1n0nne
Holding [BEWYl down, use mouse to drag To alter both values, hold I§&\%} down and If you release immediately — you
the selected (darker) area down move the mouse horizontally can enter the value using keyboard

Figure 2.5.14 Changing simultaneously two related numeric fields

Let’s return for a moment to the Render:Output panel, because it contains yet another type of the input field: a
textbox (Figure 2.5.15).You can enter a new value into a textbox in the same way as we did for the numeric
field — click it with , type the new text, and then press the . The typical text editor operations are also

available here: you can select and delete any fragment of the text, you can also copy it ([Ctri[c]) or paste ([ctri]-
from the clipboard.

Note that the text control in Figure 2.5.15 is an example of a
“specialized” field to select the file paths. On its right side there
is a little open folder icon. When you click it, you will open the file @ |PEG n :

selection window (similar to that one described on page 256). A‘e"”'e'd-

You can select a directory in that window. Of course, you can zl\fen?j;?zmggiign glfest)he
also simply type the entire path into this field. Note also that it

starts with double slash (“//”) by default. This is so-called “rela-
tive path marker”. Reading this entry, Blender replaces “//” with

its initial path — usually the folder that contains the currently Figure 2.5.15 Example of a textbox (it is a special-
. ized one, for the file or folder path)
opened file.

1 The slider located below X and Y fields allows you to get smaller render version. It is very useful for testing. The rendering time is propor-
tional to the number of pixels of the rendered image. To save your time, test the renders on the images of 50% or 75% of the final size.
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The relative path allows you to easily move the folder with the Blender model and all associated files from one
disk location into another. With the consistent use of the tag “//” at the beginning of each referenced file path,
there is no risk that Blender will have problems with finding any of the related files (texture images, for example)
in such a new place.

| think that this will end our introduction to the Properties window and the Blender GUI controls. (Some of its
panels contains also list controls — but | decided to describe such a complex GUI item in a separate section,
which you can find on page 288). During the course of this introduction we have changed the default output
image format to Jpeg (see page 65, Figure 2.5.10). We have also increased (in the Dimensions panel) the
height of the rendered image to 1024px (see page 66, Figure 2.5.13). Have you noticed that this immediately
changes the proportions of the camera frame, in the 3D View?

e In Blender there is almost no “OK.” nor “Accept” buttons. Everything what you set in its Properties window
or on the shelves (Tool Shelf, Property Shelf), is immediately reproduced on the scene.

In principle, such an instant effect is very convenient. It is based on the assumption that the screen refresh time
(of all Blender windows) is very short. This assumption may be false, when your computer does not have any
special graphics accelerator. When the CPU has to draw hundreds thousands of faces of such a model like this
La-5 in the three different 3D windows, you will observe “resistance” of the slider your are moving. (The values
displayed in the control will not change immediately). This is because any change of the GUI control forces
Blender to redraw this model in every 3D View window! This is not a big obstacle, but you can reduce these lags
by minimizing the number of displayed faces. For example — you can work only on the necessary layers, hiding
all the others (see page 38, Figure 2.2.4).

The updated Render settings, are ready for generatlon of the flnal plcture of this La-5. Before you click the final

button, make sure that at least the following layers: El EI EI are turned on. (You can check it also on
the 3D View window header. If you forget to turn layer 11 on, you will not see the wing nor the fuselage).

e Blender always renders contents of the visible layers only!

Finally — let’'s do it! Click the Render:Image button (Figure 2.5.16). (You can . .

also use its keyboard shortcut — the key). Blender will display on the
whole screen a new UV/Image Editor window. (It works this way, when you set

the Render:Display dropdown to Full Screen mode — see Figure 2.5.16. Feel [ HISRiE Full Screen ¢,
free to check the other possibilities from this list!). At the beginning the dis-
played image is completely black, then something appears (Figure 2.5.17):

Figure 2.5.16 Starting the rendering

52 <E] Back to Previous BlenderRender ¥ | |&) B

Fra:l Ve:695390 Fa:721464 La:4 Mem:332.66M (0.10M, peak 332.77M) Time:00:00.00 | Rajpams building
Click this button to ‘

cancel (stop)
current rendering @

] Back to Previous Blender Render ¥ | 60

a:4 Mem:337.20M (281.90M, peak 741.97M) Time:00:36.26 | Airborne, Part 6-99

This is the progress bar of the
rendering process

Render Result [ ¥ Combined % |

der Result nnf Sot1 41 RenderLaye ¥ "Combined & @ 75"; 4

Figure 2.5.17 The UV/Image Editor window during rendering
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Blender renders the image in a non-blocking manner (more precisely: it is calculated by separate program
threads). This allows its screen to respond to user commands. For example — you can stop this process at any
time using the button located at the top of the screen, in the Info window header (Figure 2.5.17).

Finally you should get a result like in Figure 2.5.18:

E] to Previous Blender Render ¥ %o)
Fra:l Ve:695390 Fa:721464 La:4 Mem:154.61M (281.64M, peak 741.97M) Time:00:34.19

Click this button, to
close this window and
restore the previous
screen layout

Image selection dropdown The generated image is
(allow to select any of the always stored under the
currently loaded images) Render Result name

¥ 1RenderLaye ¥ Combined ¥ @ B P

Figure 2.5.18 Image window after rendering

To save the rendered image on the disk — press the key (or invoke the Image »Save a Copy command). It

opens the file save window (see page 259). There you can determine its name and location. (In this window you
can also change the default file format — from the Jpeg to PNG, for example).

If you want to get the motion blur effect of rotating propeller blades — turn on in the Render panel the Motion
Blur option (Figure 2.5.19a). Then restart the rendering and patiently wait for the ultimate result:

a)

Fragment of the Render
section:

Box

4 Size0.750 ¢

&
L

Turn on the Sampled
Motion Blur option

Figure 2.5.19 The same image, but with blurred propeller blades
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Why | have mentioned patience? Because in the case of this Blender Renderer engine motion blur effect has
been obtained by the simplest, but most computationally expensive method. The Sampled Motion Blur renders
as many images as you have entered in the Sampled Motion Blur:Motion Samples field (in this case it is 16 —
see Figure 2.5.19a). Each of them corresponds to the subsequent animation frame. Then they are joined (aver-
aged), producing the motion blur effect.

My computer renders a single image of this La-5 (like in Figure 2.5.18) in 34s. When | turn on the Sampled
Motion Blur option, it renders the final image for 16 x 34s, that is 9 minutes. This period increases in proportion
to the number of pixels (i.e. the image surface), and is longer for the larger images. A better method of obtaining
the motion blur effect for the spinning propeller is described in the chapter on the composition, at the end of this
book (see Volume 1V).

Summary

Controls in the Properties window are grouped into panels (page 60) — as in the window panes (toolbox-
es);

Panels are grouped into contexts — the thematic sets, prepared for different types of scene data (page 60,
63);

You can select the current context using the toggle buttons, located on the Properties window header (page
60, 62);

Blender displays only those context toggle buttons, that are appropriate for the current active object (page
62);

You can shift the content of the Properties window up and down (page 61). This way each context is not
restricted by the screen height and can contain more panels. Some of them are hidden “below” the window
edge;

You can move the individual panels (i.e. change their order in the panel set — page 61) and fold them
(page 60). These settings are stored individually in each Blender file;

The basic Blender controls types are the command button (operation button — page 64), dropdown list
(menu button — page 64, 65), checkbox and radio buttons (or toggle buttons — page 64), numeric field
(numeric button — page 65, 66), and text input field (text button — page 66);

Everything you change in the Properties window is immediately visible in the model or scene. Thus there
are no OK or Accept buttons in Blender, as seen in the dialog boxes of other programs;

To render the scene, click the Render:Image button (page 67);

You can save the currently rendered image using the Image »Save command (shortcut: IIEII — page 68);

Special effects, like motion blur, may require significantly longer rendering time (page 68);

© Witold Jaworski, 2009 - 2015.




This is end of this excerpt. If you want to learn more on:

how to create/modify such a model;
how to apply a different camouflage;
how to use it to create a stunning historical scene;

see the full edition of this book:

Witold Jaworski

Virtual Z
Airplane

Third edition

Create realistic aircraft models
using free software:
Blender, GIMP, and Inkscape

“Virtual Airplane” describes how to create the aircraft
shown on its cover. It starts with the very basics, and
gradually introduces the Reader into the complete
workflow.

This guide is probably the most comprehensive book
on this subject. It contains 1339 pages, 2440 illustra-
tions. “Virtual Airplane” is available in the most popular
e-book formats:

e PDF;

¢ EPUB (for IPads);

¢ MOBI (for Amazon Fire and Android tablets);

You can find more about this book on:
http://airplanes3d.net

The complete guide was so thick that it is also available as four separate volumes. You can pick from
them the ones you are most interested in:

Virtual @
Airplane

Volume It Preperations

Virtual @
Airplane

Volume It Preperations

Virtual @
Airplane

Volume It Preperations

Virtual
Airplane

Volume It Preparations

| Preparations (pages: 168, illustrations: 227)
Preparation of reference drawings, required to create
the model. It utilizes GIMP and Inkscape (in this part
we do not use Blender).

Il Modeling (pages 444, illustrations: 771)

Describes how to form the model, using the previous-
ly prepared plans and photographs. It begins from a
general introduction to this program. Then we will
start to model the easiest parts, gradually introducing
more advanced techniques.

Il Materials and Textures (pages: 636, illustrations:
1110)

Preparation of basic materials and their textures, and
arrangement of a typical flight scene. It uses the new

Cycles rendering engine.

IV Detailing and Rendering (pages: 523, illustrations:
1000)

This volume discusses creation of various aircraft
parts, especially of the cockpit and undercarriage. At
the end it shows the composition of exemplary
scenes in the flight and on the ground.
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In the 20™ century you could make an aircraft model from
paper or plastic. In the 215t century the time has come for
yet another variation of this hobby: computer models. The
birth of this new branch of scale modeling passed unno-
ticed. Few people could spend several thousand dollars
of their private money for buying a complete 3D design
environment just for amusement. During the first years of
this century the only alternative was to use an “inappro-
priate” software — nothing to boast about... So the first
enthusiasts were quietly sitting at their monitors, creating
their models and learning from own mistakes.

The times are changing, and now all the necessary soft-
ware is available for free (it is GPL-licensed). So if you
bought your computer less than 6 years ago, you have
everything you need to get started! This book provides the
essential know-how. | will show you step by step, how to
make such models as the P-40 shown on this cover.

“Virtual Airplane” was written not only for the scale mod-
elers. It may also be useful to all who want to learn the
three most popular Open Source graphic programs:
Blender, GIMP, and Inkscape.
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